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I. Fill in the blanks with the help of words given in the box.
E - mails,

Roll No.

Section :

Electronic,

Medical,

Books,

[5 × 1 = 5 M]
Power

1) It is used to prepare ..................... reports.
2) Computer is used to send ....................
3) A computer is an ...................... machine.
4) UPS stands for uninterrupted ................. supply.
5) It is used in library to keep records of ................
II. Write 'T' for true and 'F' for false.

[5 × 1 = 5 M]

1) A computer cannot give correct results.
2) Dot matrix is a type of printer.
3) A Pen drive is also known as Flash drive.
4) Computer can store large amount of information.
5) The printed copy on a paper is called soft copy.
III. Match the following.
1) To print bills

a) Hospitals

2) To maintain records of patients

b) School

3) Making time table

c) Shops

4) To book tickets

d) Bank

5) To know details of our accounts

e) Railways
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IV. Answer the following questions :

[5 × 2 = 10 M]

1) What is a keyboard ?

2) Write any three features of a computer.

3) What are the uses of computer in a bank ?

4) What are the different types of printers ?

5) What are the main parts of a computer ?
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Vikram Text Book - 2

2

Computer Studies ★ FA - I
4

✁

C - 18

FORMATIVE ASSESSMENT - II
Class - 2 :: Vikram Computer Studies
Syllabus :
Text Book : (Lesson-3)
Page Nos : 18 - 24

Vikram
Text Book - 2

25

Time : 1 Hour

Max.Marks: 25

Name :

Section :

I. Fill in the blanks with the help of words given in the box.

Roll No.

[5 × 1 = 5M]

Device, Data, Fast, Output, Input
1) Input entered to computer is called as ....................
2) Computer works on the principle of ...................., Processing and Output cycle.
3) Calculator is also an electronic ..........................
4) We input data in computer, it processes them and gives .................
5) Computer works on ....................... speed.
II. Write 'T' for true and 'F' for false.

[5 × 1 = 5M]

1) Computer has very short memory.
2) Computer is an electronic machine.
3) When a computer works on data, it is called processing.
4) Data entered into computer is called output.
5) Computer and Calculator both are electronic devices.
III. Tick ( ✓ ) the correct option.

[4 × ½ = 2M]

1) Data and instructions together known as
a) Processing

b) Input

c) Output

d) all of these

2) Which part of a computer does all the calculations ?
a) Speaker

b) Mouse

c) Printer

d) CPU
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3) Which part of a human body works like a CPU .......................
a) Ears

b) Mouth

c) Hand

d) Brain

4) We can see more results on .................... at the same time.
a) Computer

b) Calculator

c) Mouse

d) Keyboard

IV. Match the following : (incase of finding sum of 4 and 5)
1) 2, 7

a) Output

2) 9

b) Instruction

3) Add

c) Input

V. Answer the following :

[3 × 1 = 3 M]

[5 × 2 = 10 M]

1) Mention the three steps on which a computer works.

2) Which device is used to enter data into a computer ?

3) Which part of a computer displays the output ?

4) Write any two main differences between computer and calculator.

5) Which device is used to enter data into a computer ?

❖❖❖❖❖
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Time : 1 Hour
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Roll No.

Section :

I. Fill in the blanks with the help of words given in the box.

[5 × 1 = 5 M]

Number, Shift, Backspace, Delete, Spacebar, key
1) ........................ is the longest key on the keyboard.
2) There are two sets of ..................... keys.
3) The .................... key erases character to the right side of the cursor.
4) The ....................... key is used in combination with some other key.
5) The ........................ key is used to move the cursor right.
II. Write 'T' for true and 'F' for false.

[5 × 1 = 5 M]

1) When the CapsLock light is ON, lower alphabet is typed.
2) By default, typed letters are displayed in capital.
3) Down arrow key is used to move the cursor up.
4) There are only one enter key on the keyboard.
5) ESC key is located on the lower right side of keyboard.
III. Match the following.
1) Space bar

a)

2) Enter key

b)

3) Backspace

c)

4) Delete key

d)

5) Arrow keys

e)
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IV. Answer the following questions.

[5 × 2 = 10 M]

1) Name any four special keys.

2) Which two keys are used to erase the typed letters ?

3) Name the various types of keys on the keyboard.

4) What will appear on the screen, if you press

.

5) Which keys help us to move cursor on the screen ?

❖❖❖❖❖
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Roll No.

Section :

I. Fill in the blanks with the help of words given in the box.

Ctrl + N,

Ctrl + O,

Create,

MS Word,

[5 × 1 = 5 M]

File

1) ...................... helps us to type text, correct mistakes etc.
2) The New option in the File tab helps us to ......................... a new document.
3) If you want to exit Word, then click on Exit in the ....................... tab.
4) The shortcut key for opening a new document is ............................
5) The shortcut key for opening an existing document is ....................

II. State 'T' for true and 'F' for false.

[5 × 1 = 5 M]

1) You have to open the File tab for saving the document.

2) Status bar is the bar that is located at the bottom of the Word window.

3) The Insert tab contains options like New, Open, Print, Save etc.

4) To close a file select the Insert tab from the menu options.

5) The Ribbon contains Tabs, Commands and Groups.

✁
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III. Tick (✓
✓ ) the correct option.

[5 × 1 = 5 M]

1) Which of the following shortcut key is used to print a document ?
a) Ctrl + N

b) Ctrl + O

c) Ctrl + P

2) Which of the following tab is used to open a new file ?
a) Home

b) Insert

c) File

3) Which of the following tool bar on the title bar contains all frequently used options
of Microsoft word ?
a) Insert

b) Quick Access Toolbar

c) File

4) Which of the following button contains save option ?
a) File

b) Home

c) Insert

5) Which of the following contains Tabs, Groups and Command ?
a) Home

b) Office

c) Ribbon

IV. Answer the following questions :

[5 × 2 = 10 M]

1) What are the steps of creating a new file ?

2) Write the steps of opening MS Word.

3) What is the function of File tab ?

4) How will you quit from MS Word ?

5) Explain the procedure of opening an existing file.

❖❖❖❖❖
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Section :

I. Fill in the blanks with the help of words given in the box.

[10 × 1 = 10 M]

E-mails

Mouse

Electronic

Medical

Fast

Icon

UPS

Device

Power

Power

1) It is used to prepare ................... reports.
2) Computer is used to send ....................
3) A ..................... has two or three buttons on it.
4) A computer is an ...................... machine.
5) Calculator is also an electronic .........................
6) Computer works on ...................... speed.
7) To start a computer, first switch on the ................... supply button.
8) Small picture on the desktop are called .......................
9) When the electricity goes off, the .............. makes the computer run for some time.
10) UPS stands for uninterrupted ........................ supply.
II. State 'T' for true and 'F' for false.

[10 × 1 = 10 M]

1) A CD can store a little information.
2) The printed copy on a paper is called soft copy.
3) Icons are small pictures of program shown on the desktop.
4) The first screen of the windows is called desktop.
5) Computer has very short memory.
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6) Computer is an electronic machine.
7) Dot matrix is a type of printer.
8) Computer cannot give correct results.
9) Computers are used in offices for keeping records of books.
10) Data entered into computer is called output.
III. Match the following.

[5 × 1 = 5 M]

1) To print bills

a) Hospitals

2) To maintain records of patients

b) School

3) Making time table

c) Shops

4) To book tickets

d) Bank

5) To know details of our accounts

e) Railways

IV. Tick (✓
✓ ) the correct option.

[10 × 1 = 10 M]

1) Which of the following shows the files stored on the computer ?
a) Computer

b) Recycle Bin

c) CPU

2) The thin bar at the bottom of the desktop is called ....................
a) Status bar

b) Taskbar

c) Title bar

3) A standard keyboard has ..................... keys.
a) 96

b) 100

c) 104

4) The printed copy on paper is called .......................
a) Soft copy

b) Colour copy

c) Hard copy

5) A ...................... helps in playing games and drawing pictures.
a) UPS

b) CPU

c) Mouse

6) A ....................... works very fast.
a) Computer
Vikram Text Book - 2

b) Man
2

c) Animal
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7) A ................... computer is kept on desk.
a) Laptop

b) Palmtop

c) Desktop

8) A computer stores a large amount of ...........................
a) Money

b) Information

c) Water

9) Which one of the following is not used to store data ?
a) Pen drive

b) CD

c) Mouse

10) ..................... makes a computer run when electricity goes off.
a) Windows

b) UPS

V. Answer the following questions.

c) CPU
[5 × 3 = 15 M]

1) What is a desktop ?

2) Which device is used to enter data into a computer ?

3) Write the uses of a mouse.

4) Name the three types of computers.

5) What does the blue Title bar indicate ?
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I. Fill in the blanks with the help of words given in the box.

Roll No.

[10 × 1 = 10 M]

E-mails

Mouse

Medical

Input

Output

Icon

Electronic

Eraser

Paint

Spacebar

1) It is used to prepare ...................... reports.
2) Computer is used to send ......................
3) A ................... has two or three buttons on it.
4) A computer is an ................... machine.
5) Computer works on the principle of .................., Processing and Output cycle.
6) We input data in computer, it processes them and gives ..................
7) Small picture on the desktop are called ...................
8) ................. is the longest key on the keyboard.
9) ................ program is used to make colourful drawings.
10) To erase a drawing, select .................. tool from tools group.
II. Write 'T' for True and 'F' for False.

[10 × 1 = 10 M]

1) We do not save drawing for future use.
2) We canot open a saved drawing in computer.
3) By default, typed letters are displayed in capital.
4) The backspace key is used as an eraser.
5) The first screen of the windows is called desktop.
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6) The start button is used to end any program on the computer.
7) Computer has very short memory.
8) Data entered into computer is called output.
9) Dot matrix is a type of printer.
10) A computer cannot give correct results.
III. Tick ( ✓ ) the correct option.

[10 × 1 = 10 M]

1) How many Enter keys are there on a keyboard ?
a) 2

b) 4

c) 8

2) Which of these keys are 26 in number ?
a) Alphabet keys

b) Number keys

c) Special keys

3) The thin bar at the bottom of the desktop is called ......................
a) Status bar

b) Task bar

c) Title bar

4) .................. makes a computer run when electricity goes off.
a) windows

b) UPS

c) CPU

5) Which of the following shows the files stored on the computer ?
a) Computer

b) Recycle bin

c) CPU

6) Which one of the following is not used to store data ?
a) Pen drive

b) CD

c) Mouse

7) A standard keyboard has ...................... keys.
a) 96

b) 100

c) 104

8) The printed copy on paper is called ........................
a) Soft copy

b) Colour copy

c) Hard copy

9) A ................... works very fast.
a) Computer

b) Man

c) Animal

10) A computer helps to withdraw ....................
a) Ticket

Vikram Text Book - 2
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IV. Match the following.

[5 × 1 = 5 M]

1) Title bar

a) Collection of related command

2) Tab

b) Tabs and groups

3) Ribbon

c) Contains tools arranged in different groups

4) Group

d) Blank area

5) Drawing area

e) Displays the currently opened file name

V. Answer the following questions.

[5 × 3 = 15 M]

1) Which part of the paint window contains tool arranged in different groups ?

2) Which keys help us to move cursor on the screen ?

3) Mention the steps to start a computer.

4) Mention the three steps on which a computer works.

5) What are the uses of computer in a bank ?

❖❖❖❖❖
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I. Fill in the blanks with the words given in the box.

Roll No.

[10 × 1 = 10 M]

Meteors

Ctrl+N

Paint

999

Icon

Device

Spacebar

Mouse

Items

Power

1) The default maximum value is ........................
2) In tux math aliens are replaced by ......................
3) The shortcut key for opening a New document is .....................
4) ..................... program is used to make colourful drawings.
5) .................... is the longest key on the keyboard.
6) Small picture on the desktop are called ...................
7) Calculator is also an electronic
8) UPS stands for uninterrupted ..................... supply.
9) A .................. has two or three buttons on it.
10) It is used in shops to keep details of ...................
II. Write 'T' for True and 'F' for False.

[10 × 1 = 10 M]

1) A computer cannot give correct results.
2) A CD can store a little information.
3) Computer has very short memory.
4) Icons are small picture of program shown on the desktop.
5) The backspace key is used as an eraser.

✁
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6) We do not save drawing for future use.
7) We cannot open a saved drawing in computer.
8) You have to open the file tab for saving the document
9) TuxMath is a type of space invaders.
10) The range of copies .......... repeated .......... wrongs is from 1 to 100.
III. Tick ( ✓ ) the correct option.

[10 × 1 = 10 M]

1) By destroying which meteorities we gain bonus ?
a) Red

b) Blue

c) Green

2) Which of the following tab is used to open a new file ?
a) Home

b) Insert

c) File

3) Rectangle tool is present in .................. group.
a) tools

b) image

c) shapes

4) .................... is the set of related commands.
a) Tab

b) Ribbon

c) Group

5) ....................... makes a computer run when electricity goes off.
a) Windows

b) UPS

c) CPU

6) Which of the following shows the files stored on the computer ?
a) Computer

b) Recycle bin

c) CPU

7) A ................ helps in playing games and drawing pictures.
a) UPS

b) CPU

c) Mouse

8) A standard keyboard has ................... key.
a) 96

b) 100

c) 104

9) A ..................... computer is kept on desk.
a) Laptop

b) Palmtop

c) Desktop

10) A .................. works very fast.
a) Computer
Vikram Text Book - 2
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IV. Match the following.

[5 × 1 = 5 M]

1) Title bar

a) Collection of related command

2) Tab

b) Tabs and groups

3) Ribbon

c) contains tools arranged in different groups

4) Group

d) Blank area

5) Drawing area

e) Displays the currently opened file name

V. Answer the following questions.

[5 × 3 = 15 M]

1) What is Fraction ....... to ....... keep ?

2) Name the area that is used to draw and colour a picture.

3) Name the various types of keys on the keyboard.

4) Write any two differences between computer and calculator.

5) Name the three types of computer.
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